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Conceptual Astronomy 2 Unit 1: Instrumentation

Without telescopes and cameras, astronomers would
have no means of collecting data for modern astron-
omy. The advent of the telescope 400 years ago, and
the addition of cameras, photomultiplier tubes, and
eventually CCD’s, has revolutionized astronomy and
made it much more numerical.

If you like what you
see you should take
a picturel

Prior to these advances, much of extra-solar astronomy was qualitative (using comparisons
and ratios). With the ability to measure brightness, color and position accurately and with
consistency, the quantitative (based on measurement) story of stellar evolution and our place
in the universe can begin to be understood. This unit is about the equipment astronomers use
to collect light and measure it, known as instrumentation.

In this section we begin by studying reflection and refraction, and move on to telescopes and
cameras. Reflection and Refraction are the basic principles of telescope functionality and are
required to understand these important tools. Then basic telescope technology is shown, and
the unit ends with an examination of what actually happens in a CCD camera.
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CA2 1.0: Instrumentation Objectives

By the end of this unit, students will be able to:

1.

7.
8.
9.

State the law of reflection and use it to predict the path of light rays that strike mirrors.
Use ray tracing techniques to find images in flat mirrors and concave mirrors.

State the law of refraction conceptually and use it to predict the path of light entering and
leaving glass.

Understand how refraction is used to make convex lenses that can focus.

Find real images formed by convex lenses using ray tracing or the thin lens equation.
Describe images formed by concave mirrors and convex lenses in terms of their location,
size, orientation, and nature.

Explain how to build a simple refracting telescope.

Discuss the most important characteristics of telescopes.

Compute the magnification of a telescope.

10. Compare and contrast several kinds of telescope designs.

11. Select telescopes based on the objective of the observer.
12.Understand what a CCD camera measures.

13. Define necessary vocabulary terms presented in this unit including:

Aperture

CCD

Center of curvature
Concave/Convex
Eyepiece

Focal length
Focus

Incident angle
Law of Reflection
Magnification
Normal line
Objective

Pixel

Real Image
Reflected angle
Refracted angle
Resolution
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CA2 1.1: The Law of Reflection: Lab

Purpose: To observe the law of reflection in a plane mirror and in a curved
mirror.

Materials needed: small low power laser, chalk erasers and chalk dust, flat mirror, concave
mirror (such as a makeup mirror)

SAFETY PRECAUTION: Only use a small, low power, red laser
pointer for these demonstrations. Do not point the laser at peo-
ple’s faces, or allow reflected laser light to hit faces. Repeated or
long-term exposure to laser pointer light is not good for your
eyes.

Procedure:

1. Set up the plane mirror flat on a tabletop, shiny side
up. Using the chalk erasers, create a small amount of
dust in the air. Shine the laser through the dust at the
mirror. Observe the beam as it strikes the mirror and
reflects. Sketch what you saw in the space to the right.

2. Is the angle the beam strikes the mirror equal to the angle it makes when it reflects?
YES NO (check one)

3. This is called The Law of Reflection. Write the law of reflection here.

4. The diagram at right shows a technical version

of what this looks like. The horizontal line repre- Normal Line

sents them mirror. Notice the vertical line. The .
definition of the normal line is a line that is per- e, 0@5‘@
pendicular to the surface of the mirror. Label it. K£) &

The angle of incidence is the angle between the

incoming beam and the normal. In the diagram, E— — — E——— —————
label this 6. (0is a Greek letter called theta and is Mirtor
commonly used to represent angles.) The angle be-

tween the reflected ray and the normal line is

known as the angle of reflection. Label this 6..
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CA2 1.1: The Law of Reflection: Lab

5. Write the formal law of reflection using math symbols and words.

Flat mirrors cannot focus light, or cause it to gather together in a single place. To focus light,
needed to make a telescope function, we need to use a curved mirror. The best shape for a
curved mirror is parabolic, because it has the property that all light approaching the parabolic
mirror parallel to the axis of the parabola will, when the law of reflection is applied, converge
on a single point called the focus.

L Q Q Q
L S

- In this diagram line segments QP represent light
from a distant object, the parabola is shiny like a
mirror, and F is the focus point where all the light
meets. It turns out that each reflection point
obeys the law of reflection for flat mirrors. In
some telescope designs, the camera is located at
point F.

6. Using the makeup mirror or concave mirror
Figure 1. Image source: Wikipedia and some chalk dust, shine the laser at the mir-

ror. Make sure the mirror is vertical on the desk.
Aim the laser across the table at the mirror and move it back and forth to observe the light
heading toward the focus. Sketch what you see here. Describe what you see. Are there any
patterns?

7. What is the distance from this focal point to the surface of the mirror? This is called the
focal length of the mirror.

Creating parabolic mirrors is difficult and expensive. It is somewhat easier to make a
spherical mirror. If the radius of curvature is not too great, a spherical mirror behaves
almost exactly like a parabolic mirror. In the next activity, we will investigate images formed
by spherical mirrors.
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CA2 1.2: Ray Tracing and Image Formation in
Concave Mirrors: Activity

Purpose: To learn how concave mirrors can form images of extended ob-
jects.

Equipment needed: A ruler and pencil.

Background:

In this activity, we will use the rules we learned in the previous activity about the law of re-
flection and the rules for curved mirrors. The effects you observed in the previous activity can
used to determine where images formed by the mirror will lie. These observations and exer-
cises will show you how this works.

An object such the light as shown below emits light in every direction. Sketch rays coming off
of this light bulb.

A

/ﬂ i
X7

A mirror placed nearby can intercept some of the light. But which way will the light go after
it hits the mirror? Predicting every path of every ray is difficult. However, there are two paths
the light can take that are easy to predict.

To understand how a concave mirror can focus images of extended objects like planets or the
moon, we will construct what is known as a ray trace diagram. A ray trace diagram follows
the light in an optical system to show where images form.

The principal axis of the mirror is a line of symmetry starting from
the center of the mirror, perpendicular to its surface. It is the line
essentially along the direction you are “aiming” the mirror. Sketch
the principal axis for this radio telescope (satellite dish) mirror.

I finally got 5 bars of signal...time
to phone home!
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CA2 1.2: Ray Tracing and Image Formation in Concave Mirrors: Activity
In the previous activity we observed a curve mirror redirect a laser beam so it kept passing
through a focus point. We're going to exploit that property and suggest the following rules:

Rule 1: Rays approaching a parabolic mirror from a great distance, aligned with the axis of the
mirror, will pass through the focus point.

Rule 2: Rays passing through the focus point of a curved mirror will reflect and follow a path
parallel to the axis of the mirror.

We're going to use these rules to learn how to predict where the image of an object in front
of the mirror will be.

1. A typical situation is shown at right. The focal point, or location where parallel rays
converge after reflecting, is needed to solve these problems so that is shown. Point C
refers to the center of curvature of the mirror that is exactly twice as far from the mirror
as the focus point. Label the sketch to the right with these terms: mirror, principal axis,
focus, center of curvature.

2. To see how the mirror works, we

draw rays from a distant object ap-

proaching the mirror. The object is so

far away; the incoming rays hardly di-

verge and appear parallel, heading in to ; c
the mirror and parallel to the principal

axis. According to Rule 1, these rays will

bounce off the mirror and pass through

the focus point. Sketch this.

The intersection will show where the focus point is. Mark the focus point with an f.

The center of curvature of the lens is twice as far from the mirror as the focal point. Mark this
spot with a C. Sometimes we call this point 2f.

3. This spot is where light from a distant source is concentrated. Such an arrangement might
be used in a satellite dish or a solar water pre-heater assembly on a roof. If, on the other hand,
we put a light bulb at the focus point, a beam is produced. What sort of technology is this
arrangement used for?
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CA2 1.2: Ray Tracing and Image Formation

4. Now we turn to the situation where there is a relatively nearby object such as a candle.
Light emanates from all directions from the candle, but some of it strikes the mirror. Some of it
even approaches parallel, as before, and thus will pass through the focal point.

Sketch this. Place the candle (or object) to the right of the center of curvature.

Try to
focus!

nf
5. According to Rule 2, light leaving the top of the candle will sometimes pass through the

focus before hitting the mirror, and will therefore bounce back parallel to the principal axis.
Sketch this in the box above, and include Rule 1 as well.

6. Since the light came from the top of the candle, the intersection shows where the
image will be. The candle’s image appears between the intersection and the principal
axis. Because the mirror bounces the light downward, the image will appear upside
down— between the principal axis and the intersection. In the diagram below, add the
image of the candle.

In this particular example, the image
appears to be smaller than the orig-
inal object. That is not always the
case. Depending on where you put
the object, several different out-
comes are possible. These will be
investigated in the next activity.
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CA2 1.2: Ray Tracing and Image Formation in Concave Mirrors: Activity

Use this page to practice drawing ray trace diagrams.
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CA2 1.2.1: Curved Mirror Ray Tracing: Worksheet

Using ray tracing, find the images for these three situations. Describe each image in terms of
its size (larger or smaller than the original object), its orientation (upright or inverted) and its
position (called the image distance, measured from the mirror.) For each of the following
draw a candle sitting on the principal axis (at positions >C, = C, and >f but at the same time
<(C). Then use ray tracing to find the image, and describe it.

1. Object > C.

2. Object = C.

3. Object <C, >f.
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CA2 1.2.1: Curved Mirror Ray Tracing: Worksheet
Questions:

4. Will a mirror with a long focal length appear to be deeply curved or nearly flat?

5. What other applications are there for curved mirrors besides telescopes?

6. If the object is extremely far away, approximately where will the image form?

7. Will a mirror that is larger in diameter make a brighter or dimmer image?

8. Suppose a mirror with a focal length of 4 m is used to image the moon. Approximately
where will it form an image?

9. Astronomers sometimes refer to mirrored telescopes as “light buckets.” What do they mean
by this?

10. Why is it dangerous to carry a large concave mirror around outside?
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CA2 1.3: Refraction: Activity ‘ ]

Materials needed: People, pencil, cup of water. Prisms and rectangles of
glass and a laser (optional) R ]

Purpose: To see the effect of refraction in glass and water and understand how a lens works.

Procedure:

1. Have you ever seen light make a thing appear to be bent? Try this. Put a pencil inside a
glass of water. As seen from some angles, the pencil will appear to be crooked. Sketch what
you see here.

This effect is known as refraction, or the bending of light. In this activity we will do various
demonstrations to explain why light bends as it enters a transparent material.

The main reason the effect of refraction occurs is because light slows down in a transparent
material. This occurs because transparent materials consist of atoms that intercept the rays of
light and make them stop temporarily, held in place by the atoms until they are released.
Between the atoms, light travels at the speed of light—but its overall average speed is reduced
because of the interruptions. This is just like a car that travels at 65 mph between gas stations
on the freeway, but stopping for gas lowers the average speed.

E 8,

The average speed of a car is less because it stops for gas once in a while.

5

To demonstrate this effect, try this. Form a group of 4 students and stand together shoulder
to shoulder in a row, linking arms together. Lay a stick on the floor a few feet in front of you,
representing a wall of glass. The students represent a wave front and the direction they are
walking represents the direction a ray of light would move. As the students approach the air
glass interface or junction between two transparent materials, they move at the speed of light.
After they cross the line, they slow down.
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CA2 1.3: Refraction: Activity

2. In the illustration below, the circles represent people or photons of light. The second column
represents the particles of light one nanosecond later as they approach the interface. Draw what
happens to the photon-people after they cross the line into the “glass” and slow down.

Photons in air moving at Glass
normal speed of light

3. Now try the demonstration again, this time with the interface at an angle as shown here.

Photons in air moving at Glass
normal speed of light

~

If the students lined up in a row, representing photons, keep their arms

linked, they will wind up changing direction. The same effect might

a occur if a marching band encounters a mud patch on one side. The

ﬁ band will slowly veer towards the mud because those marchers cannot
' maintain the same speed as the rest of the band.

J
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CA2 1.3: Refraction: Activity

As the light ray approaches the interface, it will bend in a predictable way. As shown in the
illustration below, a ray at an angle, approaching a material with a higher optical density (which
means it is thinner, with fewer atoms per cubic centimeter) will bend towards the normal line.

Normal line ~
Trecy, LS s
O,
7 the ,ayNN ~ REFRACTED RAY bends
o o towards the normal line
U/

q e \

90/7@/7

AR GLASS % ey

4. The opposite effect is also true. If a ray at an angle approaches a material with a smaller
optical density, what will happen?

Of course, a ray that approaches an interface at a right angle will not bend, because neither
side is slowed down preferentially.

5. Now let us consider a triangle of glass, as shown. Using the refraction rules above, predict
where the laser beam might go.

6. What would happen if the triangle were upside down?
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CA2 1.3: Refraction: Activity

7. Sketch where you think the rays will pass in the combined system below.

8. You may notice a resemblance to the shape of a magnifying glass, send from the side. This
is known as a double-convex or biconvex lens. Such lenses can be used to construct tele-
scopes and microscopes. If a continuously curving shape is used instead of triangles and rec-
tangles, the focus will be more precise. In the sketch below, every ray approaching the lens
parallel to its principal axis will wind up passing through the focus. Complete the sketch below
to show this.
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CA2 1.4: Double-Convex Lens Ray Tracing: S8
Activity

You may have noticed that the way light passes through a double-convex 4= -
lens is exactly like the rules we discovered for concave mirrors. Because k.. AV
both devices converge light to a focus, they are equivalent optically. Every- | > =
thing a concave mirror can do, a double convex lens can do as well. The rules for mirrors are
shown below. Rewrite them to apply to lenses. Note: light goes through a lens, and doesn’t
bounce back like it does for convex lenses.

Concave Mirror Rules

Rule 1: Rays approaching a parabolic mirror from a great distance, aligned with the prin-
cipal axis of the mirror, will pass through the focus point.

Rule 2: Rays passing through the focus point of a curved mirror will reflect and follow a
path parallel to the principal axis of the mirror.

1. Convex Lens Rules

2. What does it look like? Sketch rays following these rules below.

Questions:
3. Will a lens with a longer focal length than another be thicker or thinner in the center?
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CA2 1.4: Double-Convex Lens Ray Tracing: Activity

4. What is the main difference in the rules for ray tracing for concave mirrors as opposed to
convex lenses?

5. Recreate the three situations set up in the curved mirror worksheet. Draw the ray traces
for each situation as shown below. For this one, place the object (candle) at >2f or >C.
Cosmo is pointing to where you should draw your object (usually a candle.)

6. Place this object at C.

N
<

¢

7. Place this object between f and 2f (C).

Z
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CA2 1.5: Thin-Lens Optical Bench: Lab

Purpose: To show how double-convex lenses can make predictable

) o I can see my
images when the object is far away.

house from
here!

Equipment needed: Optical bench (meterstick, lens holder, small
lamp or candle, candle holder, blank paper, double convex lens
such as a magnifying glass)

Precautions: If candles are used, students should remove baggy
jackets, and tie back long hair. Open flames should be used with
supervision and due caution.

Procedure

1. Measure the focal length of the lens you are using by using it to project a focused image of
a distant light source (such as a window from across the room) onto the blank paper. When
the image is sharp, the distance between the lens and the paper is the focal length. Record
the focal length of your lens here. Use centimeters for this lab.

F=
2. Set up the optical bench as shown. Arrange the light source so it is somewhat farther than
two times the focal length of your lens. Focus the light onto some blank paper on the other

side of the lens. Move the paper until the image is sharp.

lens and holder

candle or bt
lightbulb (| more than C
A—
v
support feet support feet

Measure the image distance (between the focused image on paper and lens):

Measure the object distance (between the lens and light source):
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CA2 1.5: Thin-Lens Optical Bench: Lab

3. While you have the equipment set up, try this mini-experiment. What do you think will
happen if you cover half of the light source with your hand? Try it and see.

4. Use the thin lens equation to solve for f. Do not use the value of f from #1. We are

attempting to see if we can get the answer two different ways, which is an important strategy

1 1 1
in science. The thin lens equation is ? = d—+z, where d, is the object distance and d; is the

image distance, and f is the focal length.

5. Now draw a ray trace diagram to scale using the measured focal length and object distance,
and see if the image distance produced is the same as what you measured in #2.

6. Your teacher may ask you to repeat the lab with different object distances. Record these
measurements on your own paper.
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CA2 1.5: Thin-Lens Optical Bench: Lab
Questions

7. Why is the image always inverted?

8. In what everyday technology are lenses used to make small images of distant objects besides
telescopes?

9. The light through the lens is reversible. That is, you can place an object where the image
was and it will create a larger image far away from the lens. What commonplace piece of
technology uses this arrangement?

10. What effect do you think that diameter of a lens would have on the brightness of an image?

11. Suppose you put a light source at the focus point. What kind of image or pattern is formed?

12. One main purpose for convex lenses is for magnifying glasses. Use yours to look at some-
thing in the traditional way and answer this question: Where is the object in terms of the focal
length? Describe the image you see compared to the object.
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CA2 1.5: Thin-Lens Optical Bench: Lab
Going Further

13. Try designing a homemade camera or projector with a magnifying glass. If you draw a
small picture on a piece of transparency, then light it from behind, the magnifying glass can
be used to project the image onto a wall in a darkened room.

14. To make a primitive camera, put the lens at the end of a box and put a sheet of thin white
paper at the other end. Adjust the distance from the lens to the paper until an image of a
distant bright object is focused. Then you can trace the image on the thin paper. This was
how portraits were sometimes painted before the invention of photographic film.

%[ That's amazing! 1

iz

U/

15. Try using the magnifying glass from a distance closer than f, as it was intended. You will
not be able to focus the light on a screen. Additionally, when you look through the lens, the
image will not be inverted. It will be larger and virtual. Try to learn to draw virtual image ray
traces. (*Hint: you already did one, with the flat mirror activity.)
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CA2 1.6: Reflection and Refraction: Activity

1. Predict (by sketching) which way you think these rays will go when they hit the mirror
shown. Label the normal line, incident and reflected rays.

2. Predict (by sketching) which way you think these rays will go when they pass through the
transparent interface. Show the normal line, the incident angle and refracted angle.

GLASS

GLASS

3. Ray tracing for curved mirrors.

Draw the ray trace diagram, finding the image, for the situations shown on the next page.
Describe the image in words: Larger/smaller than the original object, upright/inverted, and
image distance compared to object distance.
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CA2 1.6: Reflection and Refraction: Activity

4. Ray tracing for convex lenses.

Draw the ray trace diagram, finding the image, for the situations shown. Describe the image

in words: Larger/smaller than the original object, upright/inverted, and image distance com-
pared to object distance.
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CA2 1.7: A Small Optical Bench Telescope: Lab ﬁ

Purpose: To build a simple telescope with lenses and investigate its properties.

Materials needed: Two convex lenses of different focal length, resolution target, and magnifi-
cation target.

Procedure:
1. Find the focal length of the two lenses and determine which one is longer. Record the
method, and the values you obtained, in the space below.

2. Hold the lens with the longer focal length in one hand, extended away
from your face. This one is closer to the object you are observing, so it is
called the objective. Hold the lens with the shorter focal length near your
face, as shown in the illustration. This one is closer to your eye so it is called
the eyepiece. Look through both lenses at once, and adjust the distance
between them until the view is clear and sharp. (Hint: the distance be-
tween the lenses will be approximately the sum of the focal lengths when
the image is focused.)

This is a simple telescope. Describe the image below, as compared to what you see without
the telescope.

3. The magnification of a telescope is how many times larger the image appears than what
your eye can see. To calculate the magnification, use the formula

-t
fi

M =
Where f, is the focal length of the objective and f. is the focal length of the eyepiece.
Calculate the magnification of your primitive telescope and write it in the space above.
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CA2 1.7: A Small Optical Bench Telescope: Lab %

4. To observe the magnification of your telescope, look at the magnification target

printed in your workbook. The idea is to look at the grid with the telescope and compare it
to the grid you see without the telescope. With practice, you can use double vision to do the
comparison. Use one eye to look at the grid with the telescope, while leaving the other eye
open to see the grid without the telescope. If you keep both eyes open, you can see both
grids at once, and compare how many of the small boxes (seen with the unaided eye) fit in
one of the large boxes (seen with the telescope-eye). The ratio should be approximately equal
to the magnification you observed already.

Observe the magnification grid on the last page of this activity, and describe whether or not
the magnification you see is similar to what the formula predicts.

5. Telescopes also make images brighter. Larger lenses can concentrate more light, and there-
fore yield brighter images. To show this effect, look at something bright inside a darkened
room with your handheld telescope. (Recall in the optical bench lab, the projected image got
dimmer when we covered half of the lens. It didn’t cut the image in half.) While looking
through your telescope have a partner cover half of the objective lens with their hand or a
piece of paper. You should be able to see a complete picture, but dimmer than before. What
this tells us is that brightness depends on surface area of the lens, and the surface area depends
on the diameter, so the wider the telescope lens, the brighter the image.

Suppose a telescope has twice the diameter of its objective than another. How many times
brighter will the image be?

6. Telescopes also enable us to see more detail than the eye can see alone. To see this effect,
hang up the resolution target across the room and ask yourself: at what numbered level do the
lines appear to merge together, showing no space between them?

Now observe the target with your homemade telescope and answer the question again. Tel-
escopes allow you to see more detail than the human eye can perceive alone.
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CA2 1.7: A Small Optical Bench Telescope: Lab %

7. If a commercially available telescope is available, or a pair of binoculars, use those
and compare the results to what your homemade telescope saw. Describe the differences
below.

8. f/ratio. The f/ratio of a telescope is determined as follows.

f()

f Iratio =
aperture

Equation for finding f/ratio

The aperture is the diameter of the objective lens. What is the aperture of your bench telescope?

9. What is the f/ratio of your bench telescope? (show your work below)

10. If a telescope or camera lens has a small f/ratio (e.g. 3, 4, 5, 6) it is called a fast lens. It
creates small, bright images that require short exposures to complete images. Telescopes and
cameras with a large f/ratio (e.g. 9, 10, 11) make larger images, but take more time to expose
the images because they are dimmer. Thus they are sometimes called slow lenses. Is the
optical bench telescope you constructed fast or slow?
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CA2 1.7: A Small Optical Bench Telescope: Lab

Figure 1. Magnification Grid.
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Purpose: To investigate the different types of telescopes and
learn which are best for a specific purpose.

Materials needed: Various types of telescopes, if available. Computer with internet access.

Background:
For each type of telescope mentioned, use the internet or the example telescopes provided to
describe it and tell about its advantages and disadvantages.

1. Refractors. Galileo first built his refracting telescope in the early 1600’s. Refracting tele-
scopes use only lenses. The telescope you constructed for the optical bench telescope is a
refractor. In a refractor, the tube is about as long as the focal length of the objective, which is
typically much longer than the focal length of the eyepiece. Draw a picture of a refracting
telescope that shows how the light passes through it.

What are the advantages and disadvantages of this design?

2. Newtonian Reflectors. Isaac Newton designed a reflecting telescope to overcome some of
the problems with refracting telescopes. Instead of using lenses, Newton’s design used a
curved piece of metal (today, we use glass) to reflect the light to secondary mirror. The sec-
ondary mirror reflects the light sideways, out the side of the tube, near the large opening at
the top. Thus the tube is approximately as long as the focal length of the mirror.

On the next page, sketch a picture of how the light goes through a Newtonian. Label the
primary mirror and the secondary mirror as well as the location of the eyepiece.
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CA2 1.8: Telescope Types: Activity

What are the advantages and disadvantages of this design?

3. Cassegrain. Cassegrain developed a telescope that took advantage of the fact that the sec-
ondary mirror in a Newtonian telescope blocks the light. Therefore the center part of the
reflecting mirror is not used. To make the telescope easier to use, Cassegrain drilled a hole in
the primary mirror and made the light bounce from the secondary through the hole, putting
the observer (and cameras) at the bottom of the telescope rather than the top. This essentially
folds the telescope in half, making the tube much shorter than the Newtonian design. Sketch
a picture of how the light goes through a Cassegrain telescope below. Label the primary
mirror and the secondary mirror as well as the location of the eyepiece. In some Cassegrain
designs a corrector plate adjusts for some aberration caused by using a spherical mirror instead
of a parabolic one. That particular design is called a Schmidt-Cassegrain.
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CA2 1.8: Telescope Types: Activity

What are the advantages and disadvantages of this design?

4. Prime Focus. A prime focus telescope has no secondary mirror but places the observer
(and/or the camera) at the focal point. Satellite dishes and radio telescopes often use this
design. Extremely large telescopes may use this design, such as the 200-inch telescope at Mt.
Palomar. The more reflecting surfaces a telescope has, the more light is focused by the mirrors.
Having only one primary mirror reduces the amount of signal lost. Sketch how such a telescope
focuses light or radio waves.

What are the advantages and disadvantages of this design?

5. Coude’. A Coude’ telescope focuses light off-axis so the secondary mirror does not block the
light striking the primary. In other words, it is tilted with respect to the principal axis, and you
do not point the mirror directly at the target like you would with an ordinary telescope. Other-
wise, it is similar to a Cassegrain design. Some satellite dishes use this design for the same reason.
On the next page sketch a pictures of a Coude’ telescope’s light path. Again, label the primary
mirror.
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CA2 1.8: Telescope Types: Activity

What are the advantages and disadvantages of this design?

6. Which type of design do you think is illustrated in each picture below? How can you tell?
(All photos by the author.)
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CA2 1.9: Comparing Telescopes: Activity

Purpose: To compare several telescopes and judge which is best for each purpose.

Materials needed: Several telescopes of differing design or several copies of advertising for
telescopes in magazines such as Astronomy or Sky and Telescope. Online advertisements can
be used from such sites as telescope.com (Orion Telescopes) or telescopes.com (a different
vendor).

Procedure: Compare several telescopes either in person at a star party, in the classroom, or
by reading advertising in an astronomy-related magazine or online. Telescope specifications
can be found at Celestron.com, Meade.com, and other places. Complete the table below,
using the instructions.

Type: Respond with Galilean (refractor), Newtonian,
Dobsonian (essentially an inexpensive or homemade
Newtonian), Cassegrain or Schmidt-Cassegrain,
Coude’, or Prime Focus. (The last two would be un-
usual in backyard or school telescopes.) Other types
exist, and if you cite them you should describe them.

Aperture: This is the diameter of the primary lens or
mirror. This will usually be the first thing an ad says
about a telescope. It if is not printed on the ad or real
telescope you are using, you can measure it with a
ruler. Often astronomers refer to different telescopes
only by their aperture as in “tonight | will be using the
100-inch telescope to photograph asteroids.”

A Newtonian Telescope with a Ger-
man equatorial mount.

Focal length: In a refractor or Newtonian telescope, this is about as long as the tube. If it is
not given in a telescope, you can compute it from the aperture and the f/ratio.

F/ratio: Usually given in an ad, but can be calculated from focal length and aperture.
Magnification with a 25 mm eyepiece: Since eyepieces can be changed easily, the best way
to compare telescopes is to use the same eyepiece. Compute the magnification using the focal

length of the objective and a 25 mm eyepiece.

Mount: The mount of a telescope is very important. A telescope which is not steady cannot
be used no matter how good the optics.
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CA2 1.9: Comparing Telescopes: Activity

Mounts can be motorized, computerized, or manual. A computerized mount can be
directed with a telescope or control pad. In addition the structure of the mount can
be one of the following:

Alt-az: The telescope only can turn left and right, up and down, and without a com-
puter, cannot easily follow the stars.

Equatorial: This telescope is designed to follow the sky and has a tilted axis that can
point to the North Star.

Fork: Fork mounts hold the telescope on both sides. They are very stable and are often
used in reflecting telescopes.

German Equatorial: This design has an axis that points to the North Star and another
that is perpendicular to that. These axes are mounted without a fork.

Special features: Special features include unusual finder scope technology such as lasers or
reflex sights, computer control, cameras, moon filters, and so on.

Limiting resolution: Resolution can be theoretically computed using the equation
R=144/D, where D is the aperture size in millimeters and R is the resolution or the
smallest separation that can be seen as separate objects, measured in arcseconds. Earth-
bound telescopes cannot usually exceed a resolution of 0.1 arcsecond due to the Earth’s
atmosphere. Any answer smaller than 0.1 should be rounded up to 0.1. Smaller values
are sharper images.

38

Describe Tele-
scope

Type

Aperture

f/ratio

Focal length

M with 25
mm eyepice

Mount

Resolution

Special fea-
tures
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CA2 1.9: Comparing Telescopes: Activity

1. In your opinion, which is the best telescope for viewing planets, and why?

2. Which telescope would be best for viewing large, dim galaxies?

3. Which telescope is easiest to carry around in your car for observing in a dark sky location?

4. Which telescope yields the brightest images?

5. Which telescope yields the sharpest images?

6. Which telescope will take images in the least amount of time?

7. Which telescope will yield the largest images with a 25 mm eyepiece?

8. Which telescopes are computerized, if any?

9. Suppose you had $2000 to buy any telescope you wanted (and nothing else more important
that the $2000 would be spent on instead). What kind would you spend it on and why?
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CA2 1.9: Comparing Telescopes: Activity

10. On this page consider analyzing an advertisement for 3 different telescopes. List the fea-
tures of each telescope, and decide which one is the best one for a particular purpose. (Pick
one: observing planets and moon, deep sky visual observing, or astrophotography.) Adver-
tisements can be found online or in issues of Sky and Telescope or Astronomy magazines as
well as photography magazines in some cases.
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CA2 1.10: Digital Camera Images Color by
Number: Activity

Purpose: To investigate how CCD cameras convert light into digital
images.

Equipment needed: 5 colored pencils

Background and Procedure: Did you color-by-number when you
were young? No? (Ask your parents.) Before computer-based art
programs, children would sometimes paint pictures using a black-
and-white drawing of an image labeled with numbers as shown
here. Using colored pencils or crayons, children would fill each
number with a corresponding paint color from a set of paints ac-
companying the drawing; 1 = black, 2 = grey, etc.

Today’s digital cameras use charge-coupled devices (CCDs) which consist of millions of indi-
vidual light sensors that essentially count the photons of light that hit them. Once collected,
the computer converts these numbers into a picture. But how are the numbers converted?
To find out, you will be doing something you haven’t done in a long time. You will be coloring!

Look at the image on the next page. Each box con-
tains a number that tells how many photons fell on
that particular digital sensor. We call these individual
brightness measurements pixels (picture elements).
Your task is to color them in. But...there’s a catch.
(Isn’t there always?) The catch is you will not have enough colored pencils to color all the
numbers differently. So you will have to pick ranges that will be represented by different
colors.

One box [ in
the grid repre-
sents a pixel.

1. Look over the table carefully and find the largest number in the table. Write it here.
2. Look over the table carefully and find the smallest number in the table. Write it here.

3. In the table that follows, designate ranges of numbers to be represented by colors. For ex-
ample, you could simply divide the range of numbers evenly by 5 and assign 1/5 of the range to
each color. Or you could decide to make 1-500 one color, and divide the remaining colors
unequally. It’'s up to you. Propose a coloring scheme in the table on the next page.
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CA2 1.10: Digital Camera Images Color by Number: Activity

]Color

Range

\4. Now color your picture according to the scale.

5. What do you think the picture represents?

Choose one: Planetary nebula, crater, Saturn, space probe, edge-on spiral galaxy.

146 161 147 144 137 137 126 137 109 68 78 115 99 114 139 150 172 174 166 161 166
141 152 139 137 118 94 104 70 97 83 55 136 163 135 135 135 156 177 167 169 169
140 125 139 136 153 111 31 82 70 52 65 41 100 92 140 157 166 185 191 190 162
140 140 139 131 60 51 95 66 64 26 10 52 36 77 102 79 123 179 180 180 185
114 100 101 35 48 56 13 10 17 4 2 29 31 52 84 103 72 179 166 141 161
39 28 34 75 93 61 150 139 153

91 61 30 42 65 59 86 145 116

88 99 95 61 44 48 26 105 135

100 108 96 71 55 89 84 135 139

83 99 101 100 85 85 98 80 137

83 73 96 94 104 84 92 109 144

99 80 81 90 98 88 110 84 30

90 80 86 94 118 94 98 75 14

79 80 81 81 134 157 118 172 67

75 86 81 110 153 119 137 138 75

85 74 88 125 105 109 128 148 68

84 96 137 164 151 127 153 136 75

127 170 178 198 170 154 162 164 67

157 139 156 159 152 164 161 139 69

125 122 123 141 146 118 100 109 61

132 159 152 155 134 151 118 137 57

232 205 147 124 135 128 116 137 70

_ ) - ] ] ] 1 I L ! ] 69 84 64 89 108 101 102 116 67
120 118 108 89 73 66 90 78 62 103 91 95 96 77 80 96 109 91 92 98 58

6. Compare your picture to your classmates. Can you see details in yours not in theirs, or vice

versa? Describe them.

7. How could we improve the detail in the image without using more pixels?

\
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CA2 1.10: Digital Camera Images Color by Number: Activity

8. How many “pixels” are in this image?

9. How many pixels would be in an image 1000 pixels wide and 1000 pixels tall?

Going Further

Consider purchasing a paint-by-number kit and

Using a different color palette than the one in the instructions
Leaving parts of the painting unfinished to show others how it works
Creating a paint by number for astronomical objects

Using a photo of an object and converting it to a paint by number as in this activity to

share
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Purpose: To learn how to use basic image processing software for later use in labs and activities
Equipment needed: Working copy of Image ] software; astronomy plug-in; computer

Background:

Image ] is a free program available for multiple platforms and used for measuring and manip-
ulating digital images. It was originally developed as a program for doing brain scans at the
National Institutes of Health, but is now used for a variety of purposes including astronomy.
It is available from http://rsb.info.nih.gov/ij/, and includes documentation and a variety of
plugins including the Astronomy plugin package located here: http://www.astro.physik.uni-
goettingen.de/~hessman/Image)/. The software installers and plugins should also be available
on your teacher’s resource disk that came with this book.

A complete tutorial on how to use Image J for astronomy is located at this web site:
http://www.astro.physik.uni-goettingen.de/~hessman/Image)/Book/index.html

The activity in this workbook is just an introduction to a few specific skills you will need for
this course.

Purpose: To learn how to open and measure basic quantities in digital imaging software such
as Image J.

Procedure:
1. Open Image J. You should see a button bar that looks like this:
|8 O O Image)

AV IVt

EFREEEA NN EEEE

Paintbrush Tool

Stk

2. Use the File menu to open the sample image sample.fits. Do not double click on the file in
your operating system. What do you think the image is?

The most commonly used commands in this course are listed below. Try each one and tell
the result after the item listed.
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CA2 1.11: Using Image J in Astronomy: Activity

e OO Image)
Ojo|z|of= 4|+ [x[Ala|@] 2|®[[su g [ 4][&] 2] [»

b

Straight line selections (right click for other types)

3. Use the straight line selections tool to draw a line across the crater’s diameter. The length
will be displayed under the buttons as you go. Once you let go of the mouse, the measure-
ment will disappear. What is the diameter of the crater in pixels?

e 00 Sample.jpg

4. Perform a plot profile (Analyze>Plot Profile)
across the crater, and sketch it here. Explain what you
think the peaks and valleys represent?

Figure 1. Picture courtesy of Jim 5 (Open the sample image sample2.fits. This image
Scala. was used in an activity called Supplementary Activ-

ity 14 in the Hands-On Universe astronomy pro-
gram (http://www.hou.lbl.gov) and is used with permission. What do you think this pic-
ture represents?

6. Use the astronomy plug-in “Aperture” under the Astronomy menu. (Information on how
to install and access this plug-in is in Appendix CA2 A-7.) Click on one of the stars. A data
table will appear where the total brightness enclosed by the innermost circle you see is dis-
played. Record the value you obtained here.
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CA2 1.11: Using Image J in Astronomy: Activity

8008 7. To make images easier to see, use the Image>Adjust>Brightness and Con-
trast command. Click “Auto” several times to see the effect on the image.
You can also manipulate the settings manually. Describe the difference in the
image.

Minimum

Maximum

Brightness

Contrast

Auto Reset

Set Apply

8. You can zoom in and out to make the picture larger and smaller. Use the magnifying glass
tool to zoom in. Click it, and then click on the area to zoom in. Press shift and click on an
area to zoom back out.

(® 00O Image)

D|o|z|o|=|4|+|x Al &£ |® o

Magnifying glass (or use "+" and "-" keys)

Stk

AVAR 1A

If you zoom in too much, what happens to the image?

9. If you point to a particular pixel on the screen, a number appears on the button bar. This
tells you the pixel value underlying that particular pixel. It also tells you the x, y coordinates
within the image. Go to 100, 74 and find out the pixel value there. Record it here:

10. Image J can do many other things such as measuring angles and areas, combine im-
ages to form color pictures, animate stacks of images to create videos, and more. Try to
use the online tutorials mentioned at the beginning to learn at least one or two more
interesting skills.
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CA2 1.12: Instrumentation: Application

1. The world’s largest telescopes have approximately a 10-meter diameter. Calculate the sur-
face area of the mirror.

2. Compare this to the area of a typical 10-inch mirror used in a backyard telescope. Convert
the inches into meters, find the area, and compare to #1 by dividing and finding the ratio.

3. Suppose the large 10 meter telescope is an /6 telescope. Compute the focal length.

4. Such telescopes do not usually use eyepieces because they are meant for use with cameras.
But just for fun, what if a 50 mm focal length eyepiece were used with such a giant tele-
scope...what would the magnification be?

5. If the mirror were used to focus light from a nearby lighthouse, located 400 meters from
the telescope, where would the image of the lighthouse form?

6. What kind of telescope is this?

7. Suppose you take a picture with the backyard telescope that exposes the camera for 100
minutes. How long would it take to expose the same picture to get just as much light for the
larger telescope? (Assume the same f/ratio.)
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CA2 1.12: Instrumentation: Worksheet

8. How big a building would be required to hold such a telescope? How many stories tall
would it be? Assume a story is 3 meters tall, and the telescope design is Newtonian. Is this a
good choice for the telescope design?

9. When observing the moon, astronomers using the telescope note the image is too bright;
they cannot take pictures of it with the camera they have. So they cover the aperture with a
mask, that covers most of the telescope’s diameter except for a small circular hole. Describe
what this does to the telescope’s

a) focal length

b) f/ratio

c) image brightness

d) magnification

10. An astronomer often uses the technique of “mosaic” imaging, where several CCD chips
are used to create a much larger imaging area. How many pixels are in an image from 4 CCD
chips each with an area of 1000 x 1000 pixels?

11. Explain why all digital images are essentially color by number.
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CA2 1.13: Instrumentation: Puzzle

Fill in the terms at the bottom of the puzzle. Then write the same letter in the box with the
corresponding number. A quotation or phrase will be spelled out in the grid at top.

W
1 2 3 4 S 6 7 g 9 10 11 12 13 14 15
H D H
16 17 18 19 20 21 22 23 24 25 26 27 28
29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44
M|A|K Y D|Y B
45 46 47 48 49 50 S1 52 53
H H N - | W L
54 55 56 57 58 59 60 61 62
M T|H
63
1. - - - - - - - MEANS "FAR-SEEING"; TUBE WITH 2 LENSES
1 3 6 5 16 13 8 37 17
2. e CLOSEST TO THE OBJECT
36 39 18 35 9 52 54 20
3 — = = P o s CLOSEST TO THE EYE
25 19 31 60 33 42 38
4 - - ¢ _ - - - - 6 _ _ DISTANCE BETWEEN FOCUS POINT AND LENS
4 49 " 7 32 46 15 12 2
5. - P - - _ _ R _ DIAMETER OF OBJECTIVE
14 50 22 30 40 53
6 R - - - - u _ _ 0 _ SHARPNESS OF IMAGE
55 23 58 51 4 63 44
7. c - - - - G R _ 1 - HAS A HOLE IN CENTER OF OBJECTIVE MIRROR
21 28 34 56 24 a7
8. P _ R _ _ O _ | C SHAPE OF TELESCOPE MIRROR FOR BEST FOCUS
26 27 48 61
9. c - - R G _ COUPLED DEVICE; USED IN CAMERAS
10 29 59
10. - P E &€ _ R _. _ €& 0O P E USED TO SEE COLORS
57 45 43 62
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CA2 1.13: Instrumentation: Puzzle
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